Capture







HIGHLIGHTS OF NEW FEATURES

1. New Capture Desktop - Experiment Mode 4
2. New Capture Desk Top - Recipe Mode 5
3. Export of Raw Data 6
4. ESCA Control Panel — Replacement for A Quick 8
5. Motor Control Panel — GPIB Interface 9
6.  Motor Control Panel - Ethernet Interface 10
7. Position Table 11
TOPICAL DESCRIPTION OF SOFTWARE
In the following sections, topics of operation are discussed in alphabetical order
1. Calibration and Setup
a. Introduction to applet 13
b. Outline of steps 14
c. Hardware configuration 14
d. Software configuration 15
e. Establishing starting calibration values 17
f Run DAC to calibrate BE span 19
g. Run Detector Width Calibration 20
h. Run V1 curves 21
i. Signature correction F2)
2. Database Functions 25
a. Creating a new database 26
b. Get recipes from another database 27
3. Depth Profiles 29
a. Open the depth profile table generator 29
4. ESCA Control Panel 31
a. Unscanned mode 31
b. Scanned Mode 32
c. Quick survey 33



Experiment Names as part of the database structure. 35

o



6.  Graphics controls

a. Chart editor 36
b. User Preferences 38
c¢. Print Utility 39
d. Spectrum color 41
e. Clipboard 41
7. Motion Control
a. Angle Resolve and tilt stage setup 42
b. Enable/Disable Buttons 47
c. Home controls 47
d. Mode control of the Joystick buttons (6K4) 48
e. Panic Button 50
f. Position Table Setup 51
g. Rotation 54
h. System Configuration (GPIB, 6K4, disable axes) 55
i. Units, coordinates 56
j. Velocity Setup (GPIB with 2100 Indexers) 57
8. MRS Tables 58
a. Construction by selecting and editing Functions 59
b. Templates 62
c. Run Controls 63

Software conventions

1. When text boxes are White they will accept data entry.

2. When text boxes are Blue they are read only.

3 Buttons or labels that are Red indicate something is turned off.

4, Buttons that are Green indicate something is turned on.

5. Buttons that are Yellow indicate something is turned on but temporarily not in

a useable state.



New Capture Desktop - Experiment Mode
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A Quick is no longer available. There is no requirement to create a recipe. When in
Experiment Mode, simply edit the MRS table to create a parameter set for the next data
acquisition. The MRS table will be stored with the data.

The Experiment Tree shows the past experiments. Selecting an experiment will recall the
stored MRS table. You have four options:

Run MRS table with a new Project/Experiment name.

Modify MRS table and run with new Project/Experiment name.

Overwrite recalled Experiment.

Save MRS table as a Recipe. To save MRS as a recipe use File menu, Save
As — Recipe.
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The Clear button provides a quick way to start a new MRS table. Don’t worry about the
existing MRS table. If it has been run it is saved. All MRS tables saved with
experiments have the Recipe name “None”.



New Capture Desk Top - Recipe Mode
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To create a new recipe just Clear the current MRS table and then compose a new table.
Then to turn the MRS table into a Recipe:

Go to File menu and select Save AS - Recipe

File out the Category name, Recipe name and description.

You can browse to an existing Category and then edit the Recipe. This provides a
fast way to add Recipes in a sequence.
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Export of Raw Data
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1. Select an Experiment. If only some regions are to be exported mark them visible.
Select Export in the File menu.

w. Review Source Information - EXPORTER

Source Project

Source Experiment

Experiment Description

| SR I~ LS R Rl P =i B ROV

Region Control for Active Expenment-—————— oy

i Export Format -

Cariial VAMAS EXCEL | Fakedata

3. Choose All regions or Only Visible regions. Select type of export.



Export of Raw Data — Cont.

The VAMAS export is an ASCII file readable by any text editor. The arrangement of
information follows the international standard for Surface Science Data. All region of the
MRS can be included in one VAMAS file. The VAMAS file can hold a complete depth
profile. This is a very flexible and well-defined export file.

To use the Excel export, Excel must be available on the computer running the ESCA
application. It does not need to be running. The export will open an Excel notebook, fill
header cells with instrument parameters and provide a column of numbers representing
the spectrum data. A crude graph is also created for quick review. There will be one
page per spectrum. All spectra for a MRS table or just the regions marked visible can be
included. A depth profile can be exported.

Fakedata.txt is an internal text file used for demonstration purposes. Any spectra can be
converted to a fakedata.txt file and then used by the Demo program to simulate the
collection of data. This can be convenient for training and remote investigation of the
program operation.
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The Export File Dialog is used with the VAMAS export. This is a standard Windows
dialog. File storage for the Excel is handled out of the Excel program.



ESCA Control Panel — Replacement for A Quick
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The ESCA control panel is used for direct access to the spectrometer.

You may change a setup condition and hit start even if a scan is in progress. The scan
will automatically abort and restart. The Time/Step can be changed. If scanned is
checked “Capture T” provides an estimate of the total capture time. The top row of
controls will change the state of the ESCA when the control is clicked. The eight
controls in the frame change state when the Start button or Enter Key is hit.



Motor Control Panel — GPIB Interface
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1. Configure Motors:
a. Set type of motion control interface
b. Turn on/off individual axes.
2. Velocity Setup:
a. Set velocity of individual axes.
3. Home Controls
a. Set XYZ: Set current XYZ position 0,0,0
b. SetR: Set current R position 0
c. GOTO XYZ: Return to XYZ=0,0,0
d. GOTOR: Returnto R =0 or 360
4, Rotation
a. Cont. Starts continuous rotation.
b. Stop Stops continuous rotation.
5. Panic Stops all motion and disables Motors.
6. Motors:  Green means Enabled. Yellow means computer control. Red
means Disabled.
7. Units:

a. XYZ: Set scale system to MM, Inches or number of steps.

b. Rotation: Set scale system to Deg, number of steps or tilt.

c. GOTO or Get * [F number is present in any white box then motors
will move to position. If all boxes empty then computer will get current
position. This is useful after Joystick movement of stage. * denotes that
the Enter Key will produce this function if form is active.




Motor Control Panel — Ethernet Interface
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The Ethernet interface and 6K4 controller allow for use of a USB Joystick. The Joystick
button has three states:

Green —

Enabled

Yellow — Motion under computer control
Red — Disabled. This secures the motion system from accidental input while
running a position table.

The button labeled “Joystick Buttons™ controls the state of the remote buttons located of
the joystick. Two buttons can be set to update the home positions or to cause forward or
back stepping through the position table. The state is toggled between these two
functions by this button. The message box in red with yellow letters describes the current

stat

c.

It will be noticed that one additional difference between the GPIB/2100 Indexer system
and the Ethernet/6K4 system is the speed of operation. The Ethernet communication
provides real time position information during the motion of the stage. The blue read
only boxes post the position in real time.

Page 51 for Position Table Setup
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Position Table
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Steps to set up Position Table:
1. Tool Bar > View > Motion Control Pnl
2z MRS Table function > PT M > Table Name (Default in this case) > Design
Button.

3. Table options:
a. Create a new table, Clear the displayed table, Delete the displayed table or
Save and run table.
b. Create a table of positions:
i. Learn positions using joystick.
ii. Move to positions using control panel, then transfer to table.

iii. Numerical entry directly to table.
¢. Table Row controls
i. Addrow
ii. Delete row
iii. Move row up
iv. Move row down
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4, Review of positions.
a. Select “numbered” buttons at end of Row. Stage will move to position.
b. Select Step forward/Step Back buttons on Table Form.
c. Select Step forward/Step Back buttons on USB joystick (6K4 controller).

5. Assign recipes
a. Select Recipe mode. Click drop down box for each row. Assign Recipe
from list.

It is very important to step through all positions before running a table. We have noticed
that the positions will not be the same on the first pass after learning. However, as the
positions are reviewed buy stepping through them in order, it is easy to refine the stored
coordinates by using the joystick learn button. The row cursor automatically follows.
This usually stabilizes the learned positions.

As the positions are reviewed, be sure limit conditions are not displayed. During the
running of a position table a limit condition will keep the stage form moving to the
correct position. You will be notified if this occurs.

To run the position table:

1. “Save and Exit” the position table
2. Enter the Project, Experiment and Experiment description information.
3. Select the Run (from top) button

During the collection of data the MRS table will display the individual MRS tables for
each position. The Experiment Name window will display:

Your Experiment Name:POS X where X is the posit.ion number.

For more details on Position tables See “Position Table Setup” pg 51
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Calibration and Setup — Outline of steps

It is very helpful if the calibration parameter values, from the previous
software, are available. IF you are upgrading from ESCAVB without a
change of operating system these steps are not required. If a new operating
system was installed then proceed with calibration.

1. Configure the registry entries for the ESCA system hardware.

2, Configure calibration parameter values that were used in previous software. If
these are not available then develop a rough set of starting values.

3. Run DAC to calibrate the span of the BE scale.

4, Run Detector Width to calibrate the detector and set the absolute BE.

5. If the ESCA Instrument has a V1 (lens focus voltage) supply in the
Spectrometer Power Supply that is digitally controlled then run V1 calibration
curves.

6. Return to the main program and set up Signature correction.

Calibration and Setup — Hardware configuration

Use the main tool bar and select the Settings menu. Select Capture Settings.

CFile Wiew | Settings Help Exit

BE ) A: Set System Reqistry Defaults

Capture Settings o

Edit Scofield Table

" Recipe Set up ESCA
& Espetime o P oo-
e Crgate a new Signature fils
rz:} Default
Temp
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Calibration and Setup — Hardware configuration - Detector

Select the Detector Tab in the Dialog. 1f a valid signature file is available then check the
Signature Correction ON box. If this is a new installation then see Signature Correction
section below.

If the “Signature file could not be loaded” message was displayed during the startup of
the program check the Signature File Path. The sig.txt file, that holds a valid signature,
must be available. The installation will make a dummy sig.txt file that makes no
signature correction. It is loaded in the ESCA 2000 folder. To use this default file make
sure the path points to the ESCA 2000 folder. If you set up a custom folder then enter
the custom path statement in the Signature file Path window.

The Dither box should be checked if a 2502 fast detector and 2503 buffer memory are
used. If a 2401 Position computer is used do not check the Dither box.

Horizontal Linerization is not available in this release.

=101

w. Capture Settings

Detector *-Rays | Spectiometer

[~ Signiture Conrection ON

Signature File Path: C:AProgram FileshESCS, 20004 sig, tat

[ Dither

[T Horizontal Linenzation

Cancel Update ‘
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Calibration and Setup — Hardware configuration — X-Rays
Standard settings for a Monochromator system.

Source Type: Al

Filter: Monochromator

Reference Energy:  1486.6 is provided as the accepted value
Please select the type of X-Ray gun controller

cowr

Note: “Other” is used for X-Ray guns that are not controlled from this
software. The VG 8730 can be controlled using the 8702 L/S.

iw, Capture Settings -0} x|
Detactor #Rays I Spectrometer '
Source Type lt‘l - } Reference Energy ]1 4565
Filter Monochromator - Spaot controller 70z Spcnt” -

Satellite Subtraction Parameters
Satellte Offset Amplitude  Filter Transmission Fraction

Mear Pk Far Pk

Non-Monochromator Systems

A. Select source Type from list
B. Select None or Foil.

None will establish a list of satellite peaks with full intensities as specified in the
literature. Foil will allow adjustment of the satellite intensities. This is an empirical
process. We assume the satellites are attenuated by the window foil. The Filter
Transmission Fraction is the Transmission for the satellite peak compared to the Primary
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peak. The Transmission Fraction can be specified for the satellite nearest the Primary
peak and the satellite farthest from the Primary peak. A linear variation in transmission is
computed for the intermediate peaks.

The Filter Transmission Fractions are determined by collecting a spectrum and then using
the Satellite subtract function in the Tools menu found at the top of the spectrum display
window. Adjust the Filter Transmission Fraction for the Near Peak until the subtraction
produces a smooth baseline in the region of the near satellite. Then adjust the Filter
Transmission Fraction for the far peak. You may need to iterate the setting a few times.
Your final Transmission values will be saved with all spectra at the time of capture. The
satellite subtraction can be performed in the Capture program or the Data Analysis
program.

Refer to Satellite Subtraction in the Data Analysis section under Manipulating Spectra.
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Calibration and Setup — Hardware configuration — Spectrometer

w, Capture Settings

Detector %-Rays Spectrometer l
; |
Spectrometer Pawer Supply lé?m e701E ~] ;
‘r
Lens Type [';«ti Probe bd l

LCancel Update l

1. Select the type of spectrometer power supply from the drop down list.
2. Select the type of lens from the drop down list.

If the Spectrometer Power Supply entry is changed then you must exit the Capture
Application and re-start it so the instrument interface and be re-initialized. You will be
reminded of this requirement when the Capture Setting Dialog is closed.

Updating the Registry

If you Cancel the dialog or use the “X” button, none of the changes made during your
session with the Capture Setting Dialog will be saved. You must use the Update button
to save your changes. The dialog will close after the Updates are complete, so it is
convenient to make all desired changes before Updating.
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Calibration and Setup — Calibration Parameters

To enter calibration parameters into the registry open the Set up ESCA applet.
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D e b
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5 Experiment i i
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Spectrometer Control Panel
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Calibration and Setup — Calibration Parameters

The calibration parameters are entered into the Configuration Table
located on the Configuration Tab.

Acquisition Eonﬁgu\r\-\ation ]Detecrorwidth] DAL ] W1 Curves

Reaqistiy entries contiol

changes will not becormne

Refiesh

configuration are displayed below. You may edit then but
manent until the commit button has been pressed,

~ Entry

BuffertdermoryType
InterruptMurmber
GPIO12Base
GPIO13Base
GFIO14Basze
SpotType
CtHZ2Null
Cthl3null
CUTANul
SupplyType
SupplyRange
MsResSettleTime
DetWidthRes
Det\WidthRes2
DetwidthRes3
DetWidthResd
DetvidthResh
PassEvRes
PassEvRes2
PaszsEvRes3

ssEvResd

sn | Configuration tab

| Type | 7 Notes

String  Type of buffer mermory board. Must be 2412,

errupt number used by buffer mernory board
used to corrmunicate with the buffer mermaory |

—_ = -
[y
L

L PR |
[agiay

12000
7.000000
13.500000

150.000000

15.000000

OvWwORDTO Fott used to communicate with the analyzer contrg
CWORDIO Port used to set the accessary hits. |
DWORD Mot used at present

DWORD Controls logic of strobe handshaking bit.
DWORD Controls logic of strobe handshaking bit.
DWORD Contrals logic of strobe handshaking bit.
DWORDO=8701, 1=6701b, 2=5724 ‘
DWORD Applies to supply type 5724 anly: 0=Range-1, 1=Rang|
DWYORD Settling time in milliseconds following a change of and
String  If detector coeficients are missing, this valuef123 is u
String  If detector coeficients are missing, this valuef128 iz uj
String  If detector coefficients are missing, this valuef128 is u .
String  If detector coefficients are m values128 is uf
String  If detector coeflicients are missing, this valuef1258 is uf
String Mot used at present time.
String Mot used at present time.
String Mot used at present time.
String Mot used at present time,
String Mot used at present time.

After entering changes to the values you must select the Commit button to wite the

changes to the registry.

Type 5000 for the MSResSettleTime. This will shorten the wait time when the resolution
is changed from 12 seconds to 5 seconds.

If you have calibration values from the HP workstation (9800 series) then one adjustment
to the calibration values is required. For each Resolution correct the pass energy. Use
the Detector With for the same Resolution as the Pass Energy.

New Pass energy = Old Pass energy + (Detector Width)/2

If you are upgrading from the DOS Vectra software or have installed a new operating
system then use the pass energy that was previously used.
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Calibration and Set up — Calibration Parameters cont.

Make the following entries to the Configuration table if data is available.

Entry Value | Type | -
Det'WidthResT 117Q1E3I707 Sty = ——ts
DetWidthRes2 7282358375 Use Existing Detector | ;
DetWidthRes3 15 ol Widths if available. ks
DetWidthRes4d 21 String  If detector coefficients
DetWidthRes5 1.45 Stri/ni If detector n:nefﬁlziints i
PaSSEVPBS'] 2 400040 AT S O . TII’I
FassEvRes2 Wﬁiﬁsﬁfa}ggz‘gws i tin
PassEvRes3 113.5646445856E Sty e tin
PassEvResd 166.599617714210 String Mot used at present tin
PassEvRes5 12.8 String Mot used at present tin
SensitivityExpRes1 St . i=iag pe
SensitivityExpRes2  0.700 Enter Sensitivity Exps | pe
SensitivityExpRes3  0.700000 only if special values pe
SensitivityExpResd4  0.700000 St| have been established. | pe
SensitivityExpResh  0.700000 = q pe
Y1 OffsetRest ; . i
1 OffsetRes? T V1 offsets and Slopes |+
V1 0ffsetRes3 142721457 for 8701B or 8724 et
W10ffzetResd 2763554599 only. Note values for |
V1 0OffzetRess 100.000000 st| VI curve setup. B
\/1SlopeRes] 0.423228 St erthi
%1 SlopeRes2 0.442913 String  Used to calculate the ™
%1 5lopeRes3 0.492126 String  Used to calculate the ™
W1 5lopeResd 0.545024 String  Used to calculate the % |
%W1SlopeResh 0.500000 SWE N
DeltaEvSpot1 (OO =id DeltaEvSpot vr
DeltaEvSpot2 0.0000 depends on crystal T
DeltaEvZpot3 0.000000 Strir  adjustment. Do after |[v't
DeltaEvSpotd 0.000000 Strin  all other adjustments r
DeltaEvspota 0.000000 otrin e
#yzhlotorsOn 0 B - —g tin
RiotarOn 0 Motor parameters, tin
RCode 1106 all 6, not used. byic
#Code 1107 DWW O BV
¥ Code 1108 DWORD Determines GRIB devic
ZCode 1109 DW( DAC for 8701 jwc
Cal_%D_ 8701 40 o [tar |
Cal_ %0 300 8724  B40 St [tan
Cal %0 1500 8724 1639 =tmm DAC for 8724 Itan
Cal_ V0 3000 8724 80.000000 Strin 5 5 dlta
Cal_W1_8701 40.000000 String  Used to translate voltar
Cal_%1_8701 40.000000 String  Used to translate voltar




Calibration and Set up — Establishing starting calibration values

If the above calibration values are not available then follow these steps:

1.

Set DetWidthRes4 to 19 eV and the PassEVRes4 to 166 e¢V. Make these entries

in the configuration table and use the Commit button to register these values.

Leave all other values as shipped.

Spectrometer Setup control panel

Set up a gold sample and be sure all supplies are on. Set the X Probe

as shown below and Start Accumulation.

If you are using a 2401 position computer then the dithered box
should be unchecked. For a 2503 Memory Interface check the

dithered box. This applies

XProbe Spectrometer Setup
Spectrometer Control Panel

at all times.

Acquisition | Configuiation | Detectowidth | DAC | V1 Curves |

1 [=] B3

Start Accumulation I - BE d Data
CenterBe BE*\(\Start Accum. readout
Window\Width 50
NumberOfPoints . 100]
Mscans | Nreads 1 f \
Resalution |4 v 8 CBE 85
Scanned @ WW 50
Horizlinearization I .
Dithered I Nbr Pt 100
Signature [ Scans 1
Ryl Res 4 s Secsfread — Sécﬁ
BindingEneragy 278 Scanned Checked ™
g gy ‘
Resolution|4 4 |Bindil  X-Rays on— 600 spot - ). .. ..
Vr 1042066334 |
V1 427 R AT T . SO e ey ey oo
Wr long 0x28b2b
V1 long (x?c30

pass energy  166.5961771

[T Collect Data Read Once l

FilterCoefficient g

Accessories

DRy 00 ~ |7 Operats ., S TR TR RS (R,

ApenurelNune v’]

FloodGun 1™
lonGun I
Interlock ¥

AccessaryMask Oxll

This will generate a spectrum of the Au 4f. With the cursor set at the center of the 7/2
peak, read the BE at the upper right corner of the spectrum display.
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Calibration and Set up — Establishing starting calibration values cont.

3. Calculate the following:

New PassEVRes4 = 166 + (measured peak position — 84),

Enter the new pass energy into the configuration table and select Commit.
4. Set up following unscanned spectrum

©o o op

f.

Remove the check mark from the box titled “Scanned”.

Center BE = 85.8.

Window Width = It will use the Detector Width. No input needed.
Number of data points = It will use 128. No input needed.
Number of Scans/Reads = 200

Start Accumulation

After spectrum is accumulated, use cursor to measure separation between the Au
4£5/2 and Au 4f7/2 peaks.
5. Calculate the following:
New DetWidthRes4 = 19 * (3.68 / measured peak separation).
Enter new Detector Width into configuration table and select Commit.
6. Make following entries:

a. DetWidthRes2 = (DetWidthRes4) / 3
b. DetWidthRes3 = (DetWidthRes2) * 2
c. PassEVRes2 = (PassEVRes4) /3
d. PassEVRes3 = (PassEVRes2) * 2

These starting values will now be used in the automatic program to refine the
calibration.
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Calibration and Set up - Run DAC to calibrate BE span.

Acquisitionl Conﬁguration] Detectoiwidth DAC ]\/1 Curves]

0

ST Please install a clean Cu-sample, tum on Xray gun to 600 spot, push
IS K ) start button when ready. This module changes the DAC calibration
constant to set the (Cu2p3/2 - Cu2s) energy difference to 810.08 eV.

The DAC calibration is very simple. Align the copper sample under the microscope.
Clean the sample with an Ton Etch. Then select start. The spectra will be displayed as
they are collected. The display window will provide information as the calibration
progresses.

The DAC calibration may fail to find the Cu 3s1/2 peak in the preset window. Small
errors in the DAC constant will cause large errors in the Cu 3s1/2 peak location. You
will need to provide an improved initial estimate of the DAC value. Run a 100 Ev wide
scan centered at 120 Ev and a 50 Ev scan centered at 930 Ev. Find the centers of the Cu
3s Y2 and Cu 2p 3/2 peaks using the cursor. Compute:

((Cu 2p3/2 — Cu 3s1/2) energy separation / 810) * current DAC

Enter this value of the DAC into the configuration table. Follow steps 1 through 3 above
to re-establish the Au 4f7/2 line position to 84 Ev. Re-run the DAC calibration.
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Calibration and Set up — DAC calibration — cont.

The DAC calibration can leave the absolute binding energy far out of adjustment. It is
only attempting to set the separation between the copper peaks to the correct value.
Return to the acquisition tab and collect a scanned spectrum at the Au 4f peaks. Use the
following setup:

CBE 85 Res 2
WW 30 Scans 2
Nbr Pt 300 Scanned box checked

X-Rays on — 600 spot
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Calibration and Set up - Detector Width Calibration

Use the cursor to find the center BE for the Au 4f 7/2 peak. Find the value of
PassEVRes?2 in the configuration table. Calculate:

New PassEVRes2 = current PassEVRes2 + (measured peak position — 84).

Enter the new value of the Pass Energy into the Configuration Table. Make the same
calculation for Res 3 and Res 4 but use the Res2 value (measured peak position - 84).
Enter these two values into the configuration table. Select Commit to record all three
updated values to the registry.

Select the Detector Width Tab. Set the run conditions for Res2, Res3 and Re4 as shown
below. Select start. Watch the calibration proceed. If the calibration fails to find two
peaks it is usually because the peaks are not well enough centered in the window. Make
small changes to the pass energy as described in the paragraph above to center the peaks
and try again. This calibration sets the absolute BE for all pass energies.

Note: Increasing the pass energy moves the peaks to lower BE.

| Acquisition | Configuration DetectoiWidth IDAC | ¥1 Curves |

_ Data E

|

, [

0 A

;

|

f |

0 1

Start I Please install a clean Au sample, tum on Xray gun to 600 spot, push ‘
start button when ready. v »

é : Res2 = Res3 | Res4 .!

Secs unscanned mode: 60 30 15 i

‘Seans for pe adjustment 7 2 1 1 7 E’
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Calibration and Set up - V1 curves

This calibration is only needed if the V1 supply is digitally controlled. The
V1 curves settings will have no effect on a model 8701 Spectrometer supply
unless the supply has a digital V1 upgrade. The optimum voltage setting
information may be useful for manual adjustment of the supply.

B xProbe Spectrometer Setup . |C
Acqisition | Configuration | Detectoiwidth | DAC V1 Curves |
CountRate Res 1 low be at 0.00 eV
: o "F"’\\
[ o
f 0 V1 End
[Calibration Title | | Operamr i |Date |5/29/2003 |
Spot |10[] :JIReviewllnclude V1 Curve set-up parameters Fesults
S T s LR Tk O S 3 Test BE %1 Stat V1 End V1 Step T/ Stepl V1 max  \Vrmax
RES 1 Low BE v 84.0 700.0 875.0 250 30.0 13705
HighBE' ] Bl R i o e
[REs2  LowBE B v 840 7500 9250 25.0 15.0 13433
High BE [~ 1 1o 2000 300 100 150 327 3
IRES3  LowBE I 840 8000 9750 250 15.0 ' 12891
HighrBE ; v 1100.0 225.0 380.0 10.0 _ 16.0 : _273.1
iREsd Low BE v 840 8500 11000 25.0 10.0 : 1236.1
High BE v 1100.0 260.0 4200 10.0 10.0 320
Run Test I [Mew Values Registry Yalues
Slope  [lintercept fSlope Intercept |
Calculate | RES 1 0.42 £9.86
: RES 2 0.44 84.02
Update registry { RES 3 D49 14272
RES 4 0.55 226.86

The V1 curve generator.

The object of running V1 curves is to obtain a set of parameters that optimize the lens
throughput for all binding energies. The voltage (V1), that is used to focus the lens, is
continuously increased over a range of voltages. As the V1 voltage is changed the
number of electron that reach the detector is changed. The goal is to set a start and end
for the V1 voltage ramp that produces a maximum detector signal away from either end.



Calibration and Set up - V1 curves — cont.

Each Resolution requires two V1 curves. All curves are created using gold as the sample.
The spot size setting does not affect the final Slope and Intercept values. It is best to run
with larger spots to improve the signal to noise.

The Check boxes, under the include column, control which curves will be run. The
button labeled “Run Test” will start the data collection. After all pairs, that have been
checked, are run use the calculate button to calculate the Slope and Offset parameters.
These parameters are used in the software to compute the V1 voltage as a function of VO
(retardation) voltage that will keep the lens focus optimized for all binding energies.
Review the computed values. The slopes and intercepts should increase smoothly and the
resolution number is increased.

Finally select the update registry button to make the new values take effect.
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Calibration and Set up — Signature correction

Return to the main Capture program

Select the Capture Settings dialog.

w, Esca Capture (C:\Program Files\Esca 2000\ examples.mdb) =

| File View | Settings Help Exit
‘ 0 eg 4 Set System Registry Defaults

Capture Settings

on
Edit Scofield Table

* Recipe Set up E5

" Experime et up ESCA .

S e Create a new Signature fild I

% D epth Pl I
Tor Performance test 'w Captul =10] x|
v Position Table Blank

o Sample Project

Detgitar w-Rays I Spectiometer

| T Signitue Conection ON i

Signature File Path: CAProgram Files\ESCaA 20000 sig.bxt

[~ Dither j

. | |7 Harizontal Linerization I b
; Areaa Peak = Au i

450
400

350 Cancel Update ]
200 {

(2]

If the ESCA uses a Model 2401 Position computer then the Dither box should not be
checked. Check the Dither box if a Model 2503 Memory Interface is used.

Remove the checks from the Signature Correction box and horizontal linerization box.

Enter the Signature File Path as shown above. This will stop the “Signature file not
found.” message that is shown when the program is started.

Select update and close the dialog box.
If you have a history of signatures in the C:\Program files\ESCAVB folder, the files can

be moved to the C:\Program files\ESCA 2000 folder. These files will have the following
endings: sig.txt.1, sig.txt.2, sig.txt.3 etc. Copy all files in this series.



Calibration and Set up — Signature correction cont.

Place an Unscanned Function in the MRS table. Set the CBE to 510eV. Input the time as
10:00 to set it to 10 minutes. Set the spot to 800 microns and the resolution to Res4. Use
Default and Temp for the Project and Experiment. The collected data does not need to be
saved. The computed signature file is saved.

Select Run.

Filza Yisw Help Settings Exit

D&t

User [admmishator
Fecipe Dese
\; Ié:gg:n % [Detat I ¢ Append & Over\Wiite
ies Default 1_{Function CBE |\Windov: Width] Spot SrzelEican:f‘TimﬁlRe\:ﬂJ

- [UnSeaned v [510{20 g [1ooo 14

GUS o I [sianatuce]

Temp

END

| l Save as Default and Temp |
ar \

UnScanned function

' . = \
Ii Area | Pesk | AutoFind | Tools | Aidp [é\_{m’ By E‘j :gl gl ||| Prei Name [Default

| EspNameTenp
1 || ExpDese: ]data for signature calculation.
|| nalsis [Raw data

After the data has been collected just leave it displayed. Then select the Setting > Create
a new signature file menu.

|| Ble iew Help | Settings Ext

|

Set System Registry Defauks

Dty B
' Capture preferences o s Heod 5 =10] x{
£t Scofield Table ) Cuitent Signature Fite. D:APaulE scaSource\Escavb\Sia bt

" Recipe Set un ESC
& Erpeiiment St 4 : : 3 B i i ]
== Create a new Sianature He\
o Detault n

(2 Temp Save the sig.txt file

2

3,}2,
1
I

L B e arain Rt i

Capture button converts the Temp
spectra into a sig.txt file.

20025 30

35 40 45 50 55 60 63 7?/635 S0 35 100105 110 1415120125

Cancel | Save

Select the capture button. The signature will be computed from the data in the spectrum
display window of the main program. The signature will be displayed in the signature

window.
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Calibration and Set up — Signature correction — cont.

Select save to save the sig.txt file and back up the last sig.txt as sig.txt.1. All other sig
files will be rolled to the next higher number.

Close Signature conversion dialog.

Re-Open the Capture Preferences dialog. Settings > Capture Preferences in main toolbar.
Enter a check in the Signature Correction check box.

w. Esca Capture (C:\Program Files\Esca 2000\examples.mdb)
| File Wiew | Settings Help Exit

‘ O e 4 Set System Registry Defaults
g Capture Settings
Edit Scofield Table

Setup ESCA

(¢ Recipe

" Esperime
ST Create a nevs Signature file 4 I
v—~3' Performance test ﬁ Cap ={0] x|
er Pasition Table Blank
Ter Sampls Praject
H-Rays Spectiometer
g o = N ]
[~ Signituie Corection ON Z
|
1
Signature File Path: [C"\F‘logram Files\ESTA 2000 sig bt i
I~ Dither -
— _ [~ Hotizontal Linerization After makin g entries
| Area | Peak | AL | select Update
il B . [ -
Cancel Update

Set up and calibration is now complete.
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Database Functions

It is highly recommended that each user create a personal Data Base!

Click on File > New > New Data Base /Protocol.

New Data Base/Protocol
ESCA Capture

Nevs Category

Open MNew Recipe
[ Export
{3 . i
Rt ¢ bl Save uick | Last Hunn'mﬂ User lAdminig[[atg
= Save As...

h: Get Categories/Recipies
Compact Database i
Backup

[D Frint Setup...

& Pririt

C:\Program Files\ESCAVEB\donald.mdb
= C:A\Program Files\ESCAVBA\dak. MDB S ,

C:\Piogram Files\ESC&4YBexamples.mdb ﬁ%} By ] ! Wﬁ[ | 33 Experimert ¥ |
C:\Program Files\ESCAVB\dak MDB e e e e
ProjMame: [ LastRunDate|
. Exp Name: [ ]
£ 11 SUeEEE S e AR : | | E#p Dese: |
400§ e --- | A B -
3504 - : ek = {1 |
300 - ;
250 A e il i
200 e - - e 1 |
150 ;
100
50 |
[ P
1 { . 4
s e b : 44 v
e Il
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Database Functions — Creating a new database

Enter the new data base name then select Save.

Save i ]’_q Escavb L] | ﬁil I l
4 wiswer exarnples.mdb
V’Zl__j.-’-"-.ﬁ! uick.mdb Prograrndb. mdb

12]] dak. DB L£17]) start.rmdb

Daon 818.mdb
1217 donald. mdb
EscaTemplate.mdb

= rndb Save I
Ll Cancel l

File nhame:

Save asty

T Open as read-only

Enter Database name. I

The categories Depth Profile, Performance Test, Position Table Blank, and Sample
Project will be automatically loaded with each new Data Base.

Drepth Profile
Ferformance test
Position Table Blank
Sample Projact

B
" v .4
1] 1B e

]




Database Functions — Get recipes from another database

Recipes can be transferred from one Data Base to another.
Go to File > Open > and select the Data Base into which Recipes are to be transferred.

Now go to File > Get Categories/Recipes

Open
Export

Save

Save 4s...

ozl

@ Print Setup. ..
L& print
Clase Get Categories/Recipes '

B o b o B B vy vy ey

C\Program Files\ESCavB\Dak-new.mdb
CiProgram Files'ESCAYB Koz, mdb
C N Program Files\ESCavBiDakK-new.mdb
CH\Program Files\ESCAYBI Koz, mdb

.

Highlight the Data Base that contains the Categories/Recipes to be transferred and click

on Open.
finen == = AN ey ‘?_I-KJ
Highlight source |~y Escave ~| & o B
Database. _ | viewer 1] start, mdb
| __;]viewer;ZDDU
21 acuick.mdb
(2] dak.t
Open

__] Programdb.mdb

File names: ]K-:-z.rndb _’:J | épen l
Files of type: ]‘,mdb _:_] Cancel l

I”" Open as read-only
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Database Functions — Get Recipes from another database — cont.

"DO NOT TRANSFER OR ALTER THE TEMPLATE DATA
BASES, ESCA Template.mdb or Programdb.mdb!!

In order to transfer a Category and/or the Recipes highlight the Category and hit the
space bar (note that after highlighting a Category or Recipe, hitting the space bar toggles
the (-), (+) signs in front of the titles).

Highlight and hit the space bar once for each Category and Recipe that is to be
transferred, then click on the Copy button.

If a Category is showing a (+) and all Recipes below the category show (-) then all
Recipes in the Category will be copied. This saves the effort of checking all Recipes.

If a Recipe shows(+) but the Parent Category shows (-) the Recipe may
not be copied. If the target database (the one you are coping to) has a
matching Category then the marked Recipes will be copied.

w. Get Category/Recipe

(ni1s2z Highlight a Categoryj

[-IDAK Hit space bar.

=159

[(+IDvepth Profils

[+l8u on 55 ; : ;
(+}&u on 55 Highlight a Recipe (s). bt
[+}1‘3.u onss Hlt space bar, w
ipe] opy
{+)Fecipe
[[IPeformance e -
{-iPosition T able Blank / X
-iSample Piojaat L

FITEST :
wE Click on Copy button.




Depth Profiles — Open the depth profile tabie generator.

o Esca Captire (D3 ~=8ix]
! Fle Yiew Help Settings Exit
Dat R
User [admricuzton
Recpe Desc
[Detaut f  Append & Over\iite
Function Spot Size|Etch Fbodﬁmitwle:[ﬁ(v{a{el i‘ Clear
Depth Ficfle 400 00 O01E] off 5 fai | | —
Auon 59 v 4l
END —
+
(23
A
M8 & Depth Profile Dialog ¥
= Templste Hame Ciesle Date  Lasthlodfied === : L2
= [fuonse R | s} LR
5d i T
Spot Size Etch Flond Gun Cycles N |ES
" [400 [oaoa 15 [oit [ 1
I | - r Proj Name ‘a
Rotats Set s Defau || Evo Namesuvey fortect
Exp Desc: o N
o [ I | = | s [ehort ccan ]
r I I+ v || Ansbsis [Rawdsts |
Fregion Defriion: = | — Scan | vistle | offsst | Yofiset ]] Yeale
| Regonttsme | cBE [ Scanned? [ww/] Scan] Ev/s]Rest | 2 { — 0 0 1
b [budl 84 [ 00000 =1l ! i
e A i
s 50 4] !
Comment
L=
X|%|=
New Cancel | Delete | Paste |||l 3
Mndnans
idf ¢f1o7 ¥ [¥i] ® <0 0
E e d

e‘—/—‘[;‘ 4, Courts 110

Ids
s | 1) € S|

[y

Sel
2. We

a.

//Cads GaZp Go 03 Hodis PhEp! PoSp3 PLSs Sbdp SiZp Ti5pl |
E‘JD&ta Acquisition.doc - Mic...| T Esca Capture (DI\ESCA Z... I ﬂs_ae_eﬁr{eh

ect the Depth Profile function from the function iist.

(2.B28% soem

suggest that the first Template be a default Template. Use this as a
temporary table. It is rare you will reuse a Depth Profile. Continue to step 4
if you are going to write over the default template.

3. If a reusable template is desired then select New. Edit the Template Name.
Go onto next step to define the spectrum regions.

4. Use the Add and Delete buttons to create a table of Region Definitions

Region name is typically the element symbol and transition label. When

this convention is used, the data reduction will automatically identify the

transition and look up the Scofield cross-section.

CBE — Center binding energy
Scanned — checked WW (window width) must be entered with a non 0

value.

Scans is number of scans. If a time is entered as hh:mm:ss, then a

number of scans will be calculated, but not shown, that equals or exceeds
the time. A default eV/step will be offered.
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Depth Profiles — Cont.

d. Scanned —not checked. WW defaults to detector width, Scans/Time is
collection time and can be entered as seconds or hh:mm:ss and finally
eV/step is not required.

€. You need to enter a Resolution number in ail cases.

f. Hh:mm:ss can be entered as h:mm:ss, mm:ss or m:ss.

5. Set up the Spot Size, Etch Time in seconds or hh:mm:ss, Flood gun state and
Number of Etch cycles.
6. The Rotation can be “On” or “Off”. If rotation is “On” then the sample holder

will rotate an integer number of rotations during each etch cycle.
7. Select Paste to Save the Table and Close the Depth Profile Dialog.
8. Use the ESCA Control Panel to set up and test the sample alignment, and ion
gun operation.
: When ready select any of the Run Buttons.
10.  The Spectrum Viewer will display the Depth Profile during the etch cycle.



ESCA Control Panel

Previous versions of the software used A Quick as a simplified control panel. This
update replaces A Quick with the ESCA Control Panel.

The first row of the panel presents check boxes allowing for the activation of the Flood
Gun (charge neutralization), Ion Gun, X-ray Gun and, if applicable, Aperture.
Changes in these parameters take effect when the boxes are clicked.

The second row and third row are grouped together in a frame. The fields represented in
the frame directly control the spectrometer. The Panel is shown with the scan variable
not checked. This is the UNSCANNED mode. The active variables are (CBE), Spot
size, spectrometer Resolution, and Capture T (time in seconds). Changes in these
parameters take effect when the start button is clicked.

ESCA Control Panel - Unscanned mode

l &. ESCA Control Panel
ﬂ)n/ off to g gl es fon\ Spectrameter Contioles

__ IS Eva

Apeitine / windows for
Flood Gun, lon Flood lon Keray Gun p=—— e
g » >f_ Gun r Gun o Operate '”D“': :'v { CBE,
Gun, N and
X-ray Gun CBE Spotsize  Resolution  Capture T ; Captu reT
pull-down ! oo ~lls x| L pull-down
menu for [~ Scans  Window  ev/step  Timelste menus for
Aperture l N T T [ ] Spot size,
\ and
Resolution
START Abort l Exit l
0,0
ESCA Control
! Panel
] .
spectrum viewer
1
: |
0 %
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ESCA Control Panel - Scanned Mode

Placing a check in the Scans box provides access to Scans number, Window width,
eV/step, and Time/step.

5 on fe = O x|
Spectiometer Controles
o l ) Sperture
~loni on Heray Bun wo—
V Gun - G Dperate Ir'l"'”': :‘v
Scaps b%}‘ CBE Spot size FHesclution  Scan Time {
activate : | —~Scans
§\ | 285 |aon ] |3 ~| | moci7 Jl

¥ Scans Window evi/step  Timelstep 1 E

| T | 2 [0 =] |

A T o Tl L e £ (N e N Sy W \

START*| Aot Exit | windows for

S~ | e | Scans,

25 Window Width
and eV/Step
pull-down
menu for

Time / Step in
Milliseconds

0

The scanned mode is especially useful for establishing the center binding energies of
those elements of interest for High Resolution Spectroscopy and also for establishing
optimum flood gun parameters.

Note that, while in the scanned mode, the Scan Time field is shaded blue.
This indicates that the Scan Time field is a Read-Only field as it is a variable dependent

on the other scan parameters.
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ESCA Control Panel - Quick survey.

Place a check in the Scans box, type 500 or 550 into the CBE box and 1000 or 1100

respectively in the Window box.
Set Time/step to 50 and click on START.
Note: The overhead time per step is 25 milliseconds. This is not included in the Scan

time calculation.

File i\_liew Help Settings  Exit

o X 5 - .
5 '+ Big Status Display 1 See Blg Dlspla} &
o b Reduction = Qottom of Panel.
¢ Dat : ] Run &=
v ESCAControlPnl | Apetture | One +=
H-ray e { 3 i [
f Mation Cantrol Prl B;:\;a:;n IH.:,ng v] , .i'a.ppend & Over Wiite End =
{ =
Scan List — -
; ' |Spat ‘alze[ Etch  |Flood Gun{Cycl
CBE Spotsize  Resolutien  ScanTime | < fann lnaonael oy iz
| —Scah :
[ 285 |eon ~| |3 || 0Ooa7 | § : Scans or Time
F Remaining
V Scans  Window evstep  Timesstep { = |
3 > i1 ; ; f /— ‘
| 1 20 | 2 Joo +| i Current Count Rate
K = i TR 3 | e
i Count Rate i;;!!. |
ey | 1] | =
START Sbort J Exit L s
00 |

| . e,
‘i Very large display of
- SR Count Rate.
l l eXt 1 This display can be expanded and moved.

Additional status parameters are then
displayed. Available during normal capture.
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Calibrating the Microscope for Correct Sample Registration

Place a phosphor sample on a flat stage and transfer it to the UHV chamber.
Use the joystick to manipulate it to the vicinity of the registration point.

Turn on the Flood Gun, and X-rays.

Set the CBE for O(1s) at~532 eV.

Choose the largest Spot size, Resolution 4, and a large number for Capture T
(3000seconds?).

While monitoring the counts adjust the Z-axis of the stage for maximum counts.
Also, insure that the “dot pattern” on the CRT is centered (side-to-side).

NOW, UNTIL THE MICROSCOPE HAS BEEN CALIBRATED, DO NOT USE
THE JOY STICK OR DO ANY OTHER MANIPULATIONS TO THE STAGE.

Turn off the flood gun (the flood gun emission may make the area irradiated by the
X-rays difficult to see).

Use the 50X magnification and the eyepiece cross hairs, adjust the Z-axis of the
microscope so that the irradiated area of the phosphor is in focus.

Now use the microscope’s X and Y-axes controls to move the eyepiece crosshairs to the
center of the in-focus irradiated area on the phosphor.

If a small Spot size is to be used change the Spot size settings to the appropriate size and
recheck the crosshair alignment using the microscope X and Y-axes adjustments.

The microscope is now calibrated.

Now use only the joystick controls to bring samples into focus and areas of interest under
the eyepiece crosshairs.
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Experiment Names as part of the database siruciure

The Project and Experiment Names are displayed in a number of places in the program.
The two names together form a unique identity for a MRS, Depth profile or one position
in a position table. Examples of the tree structures that help to find your data are shown
below.
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 Survey(.-600. eV, 1500 pts)
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+ DR1

Drmimab A MNisiabia

1 Drataab A Maiabia s

-

Set of Reduced Data '

Data Analysis keeps Reduced data with Raw Data for ease of recovery. Raw data is
never presented for manipulation. Only a copy is presented in the Spectrum Viewer.
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Graphics controls — Chart editor
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The chart editor provides control over all aspects of the Graphic presentation of the
spectra. In the following sequence of screens we will show some of the typical controls.

The X and Y axis presentation is controlled on the Axis > Scales page. The “Axis”
column in the left frame controls the focus of the “Axis” sub pages.
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Removing grid lines for X axis. The axis control was changed to Bottom to remove the
vertical grid lines in the next screen.
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Grapinic Controis — uUser Preterences
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The above sequence shows a few of the capabilities of the Graphic Editor. Many Fonts,
font sizes and colors are available. Legends can be created for Graphics with overlays.
The panel background can have be a blend of two colors. An depth profiles can be

displayed in 3D.
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The General Page of the Graphic Editor provides access to a Print Utility and Graphic

Export.
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Graphic Control — Print Utility - Cont

e

The Print Preview can be obtained from the Printer Icon or from inside the Chart Editor.
The Chart Editor provides more flexability. The Printer Icon provides convience.
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Grapuic COnirol — >pectrum coior

The color wheel icon provides access to the “Change Color and Line Style” dialog.
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The spectrum displayed in the Graphics Viewer can be placed on the Windows Clipboard
by clicking on the Clipboard Icon. The image is available for pasting into any Windows
program.
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Motion Control —Angle Resolve and tilt stage setup
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The tilt stage allows for computer controlled variable takeoff angle (TOA) analysis.
With the Motion Control Panel open select the PT M function and open the Position
Table dialog. This will enable the “Angle Setup” button on the Motion Control Panel.
Click the “Angle Setup” button on the Motion Control panel to display the Tilt Setup
dialog.



Motion Control -Angle Resolve and tilt stage setup — cont.

The relations ships described in the Tilt Setup are pictured below.

Takeoff Angle

s |

TOA Surfaceto |
: : Lens Axis - as
Sample norma shown in example.
oy
XJ / T
Sample surface
Tilt Stage

Shown with bearing support on right.

_ sfot in machined |

bearing
support

aperture plate
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Motion Control -Angle Resolve and tilt stage setup — cont.

The tilt stage allows for variable TOA analysis and by rotating the stage about its X-axis.
The TOA can be varied from 0 to 90 degrees. Mount the sample by placing it between
the solid bottom platen and the machined aperture plate.

In order for the software to work properly the following conditions must be met;
The microscope must be calibrated (refer to the section Adjusting the Microscope for
Correct Sample Registration on page #17).

Place the sample/stage in the preparation chamber so that the bearing support is located
on either the left or right side of the stage.

Lower the Z-axis to the minimum position before transferring the tilt stage to the
UHYV chamber. This is a precautionary step to avoid collisions of the tilt stage with
the hardware that protrude into the analytical chamber (i.e. flood gun, lens, ion

gun).

Raise and manipulate the stage and superimpose the microscope eyepiece crosshairs on
the grid line of the stage.

This correctly aligns the tilt stage with the X-ray beam and the lens and the R controller
will now tilt the stage.

In this example a TOA of 35° (sample surface horizontal or flat) will be initially defined
as home (0, 0, 0, 0). An approximate setting of the horizontal is sufficient for this initial
setting.
a Using the unscanned data acquisition mode and a strong elemental line adjust the
Z-axis for maximum counts and click on the SET XYZ Home(see next page).
b Now use the Y-axis to move away from the tilt axis (do not move 7).
If the counts and signal (dot pattern on the detector) remains constant, then the
stage is positioned correctly at TAO of 35° (or 55° if using the lens axis to sample
normal as the definition of TOA). If not use R (low speed) and adjust the tilt for
maximum counts and click on SET R. This accurately sets the horizontal plane
¢ Use GOTO home XYZ to return to the tilt axis. Check and refine the alignment
of the grid line on the top machined plate so that it overlaps the microscope cross
hair.

wn
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IVIOTION L ONIrol —Angie Kesolve and Uit stage setup — cont.
Aligning Sample for Angle Resolve Analysis

(-slot n machmed\k ﬁ se Z-axis controller
! anertnra nlate - ! tn alion cantar nf

i
el / sample.

Click SET XYZ...

=]

Grid line marking tilt (X) axis

{  Use the Y-axis and/or \
i R to align an area |

) away from center.
j\\ Click SET R.

Note angles entered in the R column in the position table on page 42. Enter the set of
angles you plan to use in the experiment. Use the add line, delete line etc to organize the
table as you choose.

The steps completed to this point are:

1. Select the tile configuration in the Tilt Setup dialog. Close dialog
2. Align the Home condition for the tilt stage as outlined above.
3. With the Motion Control Panel Measurement System set to degrees enter the

tilt angles for your experiment.

Now Select the Tilt Measurement System (see pg 42) in the Motion Control Panel. Your
input numbers will be converted to Raw motor steps. This conversion will account for
the tilt stage gear ratio and the Tilt Setup configuration. The final table is displayed

below.
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Motion Control -Angle Resolve and tilt stage setup — cont
: GOTO K2 f
B Select tilt measurement\ll X xz| B | j
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5 190 Deg | .00 0.00 200 10500

The Recipes are assigned by selecting the Recipe Display Mode and selecting the

Recipes from the dropdown dialog.




VIOTION CORNIFrol — Fnabie/isanle Suions
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Review the last three screens that show the Motion Control Panel. Notice the Motors and
Joystick buttons take on the colors Red, Yellow and Green depending on the state of the
Motion control system. Clicking either button will toggle the state of the Motors or the
Joystick between enabled and disabled (Green or Red).

1. Disabling the Motors turn the power to the motors off.
2. Disabling the Joystick block Joystick control of the motors.

The yellow state is displayed during computer-controlled movement. Notice that a
number of control panel buttons are disabled during computer-controlled motion.

NOTE: If the motion system stops working it is often sufficient to Disable the Motors

and then re-enable them to restore normal operation. Your Home position will not be
lost.

Motion Control - Home controls

el e o 9 3
[ Set current {(x,y.7) i Heinis Captiolss [ Set current (1) I
. & |
| 111
b’osmon to (0.0.0) N home dnahlex 3 position to (0) J
| SET ;
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Ux,v,z)z(o,u,o)J Lo(1)~(0) J

The GOTO R button causes the rotation position to return to 0 deg or 360 deg.
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Motion Control -Mode control of the Joystick buttons (6K4).

Configure
Motorg

............................

i~ Home Controles

" Jostk :’ﬁuﬂm;'ujhn.’f;‘ihil%n‘;i

GOTO  xvZ | 3

Configure! Joystick
Motors | bultons

~ Home Controles
Joystk home enabled

5
|
CseT x| R |§
Goto xz | R ||

|

Clicking the “Joystick buttons™ button toggles the function of the two front buttons on the
Joystick. When the Joystick home is enabled, then the left front button set the current
XYZ position as home. Likewise, the right front button will set the current rotation
position as home. This is very convenient for initially setting a home position while
observing the sample with the microscope.

|

Later, when reviewing the learned sample positions, the mode can be switched. When
the home function is disabled in the Motion Control Panel then the Joystick Step Next/
Step Back Function is enabled in the Position Table.



—

Trazrotial-

B

.....
%

XYZ Set Home R l
Dauvn gicp 1 Usiiivii ?gtﬁi“_"/,

The joystick controls motion along the X (Ieft/right), Y (forward/back) and “Z axes (press
center button while moving the Joystick forward-back). Rotation is obtained by twisting
the outer ring clockwise/counter clockwise.

The Get function “Gets “ the current coordinates and fills or updates in the position cell
in the position table.
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The PANIC button is used to immediately stop all motion!
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All motion is stopped and power is removed from the motors. The current home location
is not lost.

To restore normal operation select the Motor button and then the Joystick button. After
both buttons turn green, the Motion system will be ready for operation
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Motion Controi - Position Table Setup

Setting up the Position Table disables Recipes so, when possible, compose Recipes
beforehand.

Use the Function pull down menu and select PT M. Then click the design button (“The
Pencil”) Icon. This activates the Position Table — Multi Recipe Panel. If the Motion
Control Panel is not open it will be opened along with the Position Table.
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SET rioIine

Go to the microscope and set the cross hair on the axis of rotation. Go to the SET row of
the MOTION Controls Panel and click on XYZ.

Move toward the edge of the holder, preferably the first sample. SET this position as

Home for R. An initial reference co-ordinate system is now set that can be reproduced it
there is a glitch.

57




Motion Control - Position Table Setup cont.

Learning Positions

There are two modes of adding rows to the position table. They are controlled by the
radio buttons in the Get Current Positions frame.

i. Select the Update mode. Each time the Add Line button, on the position table
form is clicked, a blank row will be added to the table. When the Get Position
button is clicked the values for each axis will be updated.

2. Select the Auto Add mode. Rows are added and filled in each time the Get
Position button is selected.

The Update mode is convenient for updating or refining the coordinates for an existing
table. The Auto Add mode is best when building a table from scratch.

NOTE: The Joystick Get Position button works the same as the button on the form.
With Auto Add selected, you can learn all your positions without going back to the
computer,

Choose one of the above modes of operation. Put the cursor on the X axis cell of the first
row. Row (1). The X axis cell is arbitrary but a good practice. With the stage aligned on
position, (Pos 1) click the Get Position button on the Joystick or on the Position table
form. The Special Function button is the Get Position button for the old Joystick. If you
chose the Update mode the coordinate celis of row (1) will be filled. If you chose the
Auto Add mode then you will have a new row at the bottom of the table with the values
for the current position.

In the update mode, you will continue to put the cursor on the X column of the row that
matches your sample. You will move to a new position and select the Get Position
button.

In the Auto Add mode you will continue moving to new positions and selecting the Get
Position button. When you are finished, delete any rows left over from previous tables.
You will then be left with a table properly numbered.

The screen on the next page shows the controls discussed.
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1 ONIFrQl - POSIoN [ anle detp cont.
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NOTE: With the GPiB/2100 Indexer system the Joystick operation is not connected
to the computer. Continuous poiling of the Indexers to see if there has been Joystick
activity leads to less reliable operation. The “Goto or Get” button on the Motion
Control Panel is used to request current stage position. This provides the required
update. The Motion Control Panel button ONLY updates the Motion Control
display. The Get Position Button on the Position Table and the Joystick update
both the Motion Control Panel and the Position Table,
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Motion Control - Position Table Setup cont.

After the desired positions have been entered into the Position Table click on the Recipe
button. This expands the Position Table — Multi Recipe Panel so that Recipes may be

assigned for each position.

Save the table and Run the analysis.

w. Pasition Table - Multi Recipe
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comments may be
inseried here.
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If, after acquiring the data set, more data is needed, create the appropriate Recipes and
insert them into the previous position table.
Then Save again.

Previously stored position tables may be reused and edited to accommodate different sets

of samples.
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interface.
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This configuration dialog will be displayed when the software is first installed. Your

responses will be stored in the registry.
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Motion Control - Units, coordinates.

=

e

RYZ |mm ] Rotation Ideg vl

Read only — Current position

§ Goto * |
| | or Get J
|

_— k] 4 X7 XJF 7 D\
i H i i f i Manual entry - (A, 1,2,

B
|
I

XYZ Scale units are:
1. mm = millimeters
2. inch = inches
3. raw = number of motor steps (250,000 / inch)

R Scale units are:

1. deg=degrees

2. raw = number of motor steps (36,000 / turn — 6K4 or 25,000 / turn GPIB)

3. tilt = converts TOA (Take Off Angle) to raw. See Motion Control — Angle
Resolved.

Enter position coordinates and then click Goto (or keyboard Enter) for manual control. If
no position coordinates are entered (i.e. White boxes are empty) then the current motor
positions will be recovered from 2100 Tndexers. This is not required with 6K4.
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IVIQUION QHEIrQL— VeloCity dep (GPIB with 210U indexers only)
The Velocity Setup only controls the velocities for computer, not joystick control.

- Velogity & =181 x|

The velocity setlings are in mm/sec or deg/sec.
These settings only control the velocities for computer
control. The joystick velocities are set manualy in the
2100 indexers.

Adgl wekment ranae

X Axis 0.5 0.1 to 5 mm/sec

Y Axis 05 0.1 to 5 mm/sec

Z Axis 0.5 0.1 to 5 mm/sec

R Axis 0.5 1 to 180 deg/sec
Command1
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MRS Tables

A capture screen, with a new database loaded, will show no MRS table. Select a Recipe
to load the MRS table constructor functions.

% Esca Capture (D:\ESCA 2000 G\start.mdb) [_[=
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In this case the Sample Project > Default Recipe was selected. The MRS for this Recipe
is a simple survey. We can start from this MRS and modify it to create the parameter
table for the Spectrum capture desired. First, a review of the possibilities.
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iRS Tables - Construction by selecting and editing Functions.

Adding a new function.

Chckonadd _—
function. |

Function

Survey
ResHi

k—ﬁ—q uxinl:u;i | > Euﬁ-li

Select a Function

|LBE |Window idth|Spat Size| Scans/Time| Restt| Ev/Step]|

[ ji i i i

| Depth Profile
10System
Etch

Neulralzer : Select a function.
Bloop : =
T Single

|Xpause

GEC DGO

|
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MRS Tabies — Construction buy editing Functions cont.

FUNCTION TABLE CONTROLS

Clear| = Clear MRS table. Leaves top function.
4 ! | Set next row up the active function
+ . Set next row down the active function
¥ || .
4 | | Add new function
‘ ?; . Delete current function 5
| SRS f B
F | | Move current function up one row
4+ | | Move current function down one row

Lhe controls Tor the manipulation ot the tunctions 1n the table are described above. 1he
underlined A and X can be executed from the keyboard by using Alt-A or Alt-X.

} & Duick { % i_ast Running User |administrate. End c-?}
1 |Function LBE |'wWindow Width| Spot Size| Scags/Time|Rest|EV/Step = || | b
Survey ~ |0 [1000 00 1\ |4 [ z

G Survey 1000 = | & 'A \ 4+

i oC4diiy/ 1iHiC =7 | *
5 i

A Function (in this case a Survey) creates a list of default data acquisition parameters.
The default values are often ok but it is quick to customize the values. For example, the
number of Scans is often increased or the BE conditions are changed.

NOTE: Time, stated as hh:mm:ss, can be entered instead of number of scans. The
program will compute a number of scans that most closely matches the requested
time. A calculation of zero scans will be run as one scan.

The default parameter eV/step is set optimum for the selected resolution (Res#).
This applies to high resolution (ResHi) and high Sensitivity (HiSen) scans.




MRS Tabies - Construction by editing Functions cont.

NOTE: TAB or the mouse must be used to step out of the Function column.

In the Function column the arrow keys move up and down the Function list and not

from Function to parameter columns or Function to Function.

BELS) LRV WU palalliud Ciuilin Le

The arrow keys move up and down or side to side in the parameter columns.

SHIFT TAB will tab right to left. It is fast to fill in a table and then “arrow” down the
scan column and set the number of scans at one time.

High Resolution scans and High Sensitivity scans may be added to the table as required
by the analysis. For these two cases the binding energy is changed form the default
values. This is quickly accomplished by “Arrowing” down the BE column.

cans/Time|{ResHEV/Siep =

i jPunchion LBE |windovw Widih|Spot Sizs(5
Survey ~ |0 (1000 800 2 4 1 =
G Survey 1000 + | &/ |Survey
2 |Function CBE |'\Windaw “idth| Spat Size| Scans/Time|Resl | EV/Step
ResHi v |284 |20 300 5 2 0.085
G HR R2 v| Zl|C1s
3 |Function CBE [Window width| Spat Size| Scans/Time| Rest] Ev/Stepl
w 1530120 300 i3 iz joOss |
i2 1 .#j0 s
4 |Function CBE |Window “Width|Spot Size| Scans/Time|Restt|EV/Step
ResHi ~ |100 |20 300 A 2 0.065
G HR R2 ~ | Z|Si2p
5 |Function CBE | Window Width| Spot Size| Scans/Time|Res#|EV/5tep
ResHi ~ [348 |20 300 10 2 0.065
S e Pl | e 7\\
\LRegion name J
. B
o | [

The above Multi Region Scan (MRS) has a survey and four high resolutions Region.
Each region has been named for ease of identification. The region name will default to
Region 1, Region?2 etc if the names are not entered.
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MRS Tables — Templates

3 _|Function LBE |Windo T Step!
3l = = 1EN acn .C‘ ’1‘!‘.’\‘!“._!‘1.".“7?“.
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4 |Function LBE ‘«\J’im:lt:uh».‘v : ,4,4%

HiSen ~[50 250 o~ EE
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G Gen R3 | & lowBF” <1
5 {Function LBE |% ,Aﬁ{/\}idlh Spotl Size|Scans/Time|ResH|EV/Step
H|Sen 5210 600 3 3 |z
| v‘ & [Ferri Region
P Sm R ENDs
e ranpa =

The table above displays three templates for the high sensitivity function. After selecting
a function you can drop-down the list of named templates that hold a set of default
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2 _|Function CEE [Window Width| Spot Size[Scans/Time[Rest#[EV/Step|
ResHi ~ 284 |20 300 |5 |2 [omss |
GHRRZ = § ZijClis
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To create a new template:

Select the New Icon.

Enter a new Template Name.

Enter the parameter values for your template in the appropriate boxes.

The check box will lock the value so it can’t be changed from the MRS table.
Select the Paste Icon to save the template and post the name to the Function
list.
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1 |Function LBE |"Windaow Yidth|Spat Size| Scans/Time | Resf|EV/Step
Survey ~ [0 [1000 ETIE '
G Survey 1000 v | @ [Suvey
2 |Function  |CBE|Window \Width|Spot Size| Scans/Time| Rest | EV/Step
BagH) < |74 120 L ;":’ " nnes
G HR R < | 7t s
|

g 4|

nll. i (+l ] Proj Name:[
o Exp Name:[

Exp Desc: Nemps:':a{y E uperiment

l | Analysis: {Raw dataiziti s

Befor running the MRS table a Project Name and Experiment Name must be provided.
These two names taken together create a unique idenity for the MRS in the database. The
Experiment Description is for additional information that make clear the Experiment.

The discription is not used for finding the data. It is supplied after the data is recovered.

Most of the time there will be a Project Name and Experiment Name in the input boxes.
These names will be left from the previous state of the Capture Program. It is most likely
you will not change the Project Name. This assumes that you will do many Experiments
for one Project. The typical operation will be to write over or modify the Experiment
Name. You may add letters or numbers to show a sequence in the experiments.

After taking care of the Project Name, Experiment Name and Description Select a Run
Control.

=

Three Run Controls are found above the Function Table. The lines in the Functio
Table can be run to capture a sequence of regions.

The Run button runs the complete Function Table from line 1 to the bottom of the table.
The second button labeled One only runs the current active (highlighted) line.

The bottom button labeled End runs from the current active line to the bottom of the
Function Table.Once a capture is started additional buttous appear to control
terminatioii.
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Pause, Stop , Abort and Append buttons appear to the right of the three run buttons.

™ Append Run *=
o Over'wnte = = —— : |
* Owver'wh Qne += ‘f h*f:,
End o= Pays Ak
- — = oyt —“.zjt

Pause — MRS tables. Pause will temporarily stop the capture so a change can be made
to the number of scans or capture time. In order to continue, click again on Pause.

Pause — Depth Profiles. Pause will temporarily stop the capture of a scan. During the
pause the etch time or number of cycles may be changed. In order to continue, click
again on Pause. If Pause is used during the etch cycle the current etch cycle will finish
and then the Pause will be executed.

g

ause — Position Tables. Pause will effect the MRS table of the current position.

Pause — Ion Etch, The stand alone Etch function will pause during the etch. The etch
time can be changed.

Stop — MRS Table. “Stop” is used to stop a scan at the nearest endpoint. If the
capture is unscanned then the capture will stop immediately.

Stop — Depth Profiles. “Stop” acts as an abort during a the Depth Profile.

Stop — Position Tables. “Stop” will stop the Position Table MRS at the end of the
running spectrum. The Position table will be aborted.

Abort stops all operations immediately. The data taken up to the time of the Abort is
saved.

Append : Normal operation is Overwrite. If a new experiment name is not entered,
then the re-run of the current experiment overwrites the existing data. If you want to
collect additional data under the current experiment name then you may use the Append
mode. This can be used to add a new region to the experiment or to collect additional
data for one or more regions. The Appended data may easily be added to the original
data by using the Add Spectra function in the Tools menu. The Append mode reverts
back to the overwrite mode after the Appended data has been collected.
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liﬁx

The data being acquired will be visible in the Spectrum Viewer.
During data acquisition binding energies may be measured by placing the cursor on the
peaks, their binding energies can be seen below in the Display Bar.
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The Spectrum Viewer is used to display the current active spectrum and it will always
be displayed in this window during data acquisition.

Below the Spectrum Viewer/ Document Control area is a display bar that shows the
status of the capture process.

During a capture the Idie indicator will switch to Running.

The information inside of the parenthesis will show the Recipe that is being run.
Additional parameters of the capture will also be displayed in this window.

The next window in the Status Bar displays the cursor parameters.

The third window displays the Scofield Table showing probable peak assignments as a

function of cursor position.
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on ata Analysis

The data analysis provide for Compositional Analysis, Peak Fitting, Depth Profile
analysis and other data manipulation.

To open the Data Analysis from the Capture program Click on View > Data Reduction.
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